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Using ImageJ with file formats created on our microscopes
There are excellent manuals and tutorials available on the NIH ImageJ website. In addition to the official ones, the ImageJ Documentation wiki and Fiji Cookbook are
good.

Components needed
ImageJ (download from ImageJ website)

Bio-Format Plugins for ImageJ (download from OME website)

an alternative is to just get Fiji which is just ImageJ packaged with some commonly used plugins, including Bio-Format (download from Fiji website)

bit-depth
the system outputs 12-bit data and images can be acquired with 8, 12 or 16-bit resolution

image resolution grey scale level lif file type

*16-bit files with 12-bit resolution will appear dark unless the intensity is scaled
e.g., set Minimum displayed value to 0 and Maximum displayed value to 4095 for full scale display

1. Do Image > Adjust > Brightness/Contrast...
2. click on Set and enter the desirable displayed values or click on Auto to use the min and max intensity values stored in the

image

8-bit 256 8-bit, uint8
12-bit* 4096 16-bit, uint16

16-bit (scaled from 12-bit) 65536 16-bit, uint16

some software cannot deal with 16-bit files, you can convert the image to 8-bit by doing Image > Type > 8-bit

lif
1. launch ImageJ/Fiji

2. drag and drop the lif file onto ImageJ's status bar to open the file

3. after a few moments of thinking, loci_tools' Bio-Formats Import Options dialog box will open
for Stack Viewing, set View stack with: Hyperstack
under Color options, check Autoscale if you want to use the min and max intensity values stored in the image

4. click OK and wait for loci_tools' Bio-Formats Series Options dialog box which allows selection of specific contents

5. select the desirable images and click OK

multidimensional files
sequential multichannel file opens correctly using View stack with: Hyperstack

sometimes simultaneous multichannel files may open with channels interleaved, and here is a workaround
1. need to use View stack with: Standard ImageJ and Stack order: Default (xyzct)
2. convert the opened stack to hyperstack, do Image > Hyperstack > Stack to hyperstack..., use the default xyczt order and fill in the appropriate c, z, t value

other simple tasks
if you want to break down the multidimension series e.g., XYCZT

1. do it during file open with the Split into separate windows options
Split channels, focal planes, timepoints

2. after the image series is opened as a hyperstack, you can do Plugins > LOCI > Stack Slicer and check the appropriate options

If you feel like breaking down a lif into individual TIFF, you can try this ImageJ macro

macro "Break up a lif into individual TIFF" { 
// open the file manager to select a lif file to break it into TIFFs 
// in this case, only the metadata specific to a series will be written 
 
path = File.openDialog("Select a File"); 
 
run("Bio-Formats Macro Extensions"); 
Ext.setId(path); 
Ext.getCurrentFile(file); 
Ext.getSeriesCount(seriesCount); 
 
for (s=1; s<=seriesCount; s++) { 
// Bio-Formats Importer uses an argument that can be built by concatenate a set of strings 
run("Bio-Formats Importer", "open=&path autoscale color_mode=Default view=Hyperstack stack_order=XYCZT serie
out_path = getDirectory("image") + getTitle() + ".tif"; 
saveAs("tiff", out_path); 
close(); 
    } 
} 
   

https://rsbweb.nih.gov/ij/docs/index.html
http://imagejdocu.tudor.lu/
http://fiji.sc/Cookbook
https://rsb.info.nih.gov/ij/download.html
https://www.openmicroscopy.org/site/products/bio-formats/downloads
https://fiji.sc/Downloads
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...

(more to come)

metadata
the metadata from the header of the lif file relevant to the image opened can be displayed by Image > Show Info...

the same information can be displayed if you check "Metadata viewing, Display metadata in results window" option in the Bio-Format Import Options dialog box

here is an example of the metadata in a xyz series, most entries are self explanatory, additional comments or commonly used parameters are in [ ]; also, there are
repeated entries and entries not applicable for our installation e.g., bUseCARS, bUseMP, and bUseSTED

 [all these up to the long dash line below are metadata recognized by Bio-Format] 
 DimensionOrder = XYCZT [slice order] 
 IsInterleaved = false 
 IsRGB = false 
 LittleEndian = true 
 PixelType = uint8 
 SizeC = 1 
 SizeT = 1 
 SizeX = 4096 
 SizeY = 16 
 SizeZ = 240 
Application 1 = LAS AF 
Application 2 = LAS AF 
Application 3 = LAS AF 
Application 4 = LAS AF 
Application 5 = LAS AF 
ChannelDescription|BitInc 1 = 0 
ChannelDescription|BytesInc 1 = 0 
ChannelDescription|ChannelTag 1 = 0 
ChannelDescription|DataType 1 = 0 
ChannelDescription|IsLUTInverted 1 = 0 
ChannelDescription|LUTName 1 = Red [ ] 
ChannelDescription|Max 1 = 2.550000e+002 [max intensity] 
ChannelDescription|Min 1 = 0.000000e+000 [min intensity] 
ChannelDescription|NameOfMeasuredQuantity 1 =  
ChannelDescription|Resolution 1 = 8 [bit depth] 
ChannelDescription|Unit 1 =  
ChannelScalingInfo|Automatic 1 = 0 
ChannelScalingInfo|BackgroundLutName 1 =  
ChannelScalingInfo|BlackValue 1 = 0 
ChannelScalingInfo|GammaValue 1 = 1 
ChannelScalingInfo|WhiteValue 1 = 1 
DimensionDescription|BitInc 1 = 0 
DimensionDescription|BitInc 2 = 0 
DimensionDescription|BitInc 3 = 0 
DimensionDescription|BytesInc 1 = 1 
DimensionDescription|BytesInc 2 = 4096 
DimensionDescription|BytesInc 3 = 65536 
DimensionDescription|DimID 1 = 1 
DimensionDescription|DimID 2 = 2 
DimensionDescription|DimID 3 = 3 
DimensionDescription|Length 1 = 2.460327e-005 [physical length x, m] 
DimensionDescription|Length 2 = 9.012186e-008 [physical length y, m] 
DimensionDescription|Length 3 = 1.002885e-005 [physical length z, m] 
DimensionDescription|NumberOfElements 1 = 4096 [logical size x, pixel] 
DimensionDescription|NumberOfElements 2 = 16 [logical size y, pixel] 
DimensionDescription|NumberOfElements 3 = 240 [logical size z, pixel] 
DimensionDescription|Origin 1 = 1.376765e-020 [physical origin x, m] 
DimensionDescription|Origin 2 = 1.847741e-008 [physical origin y, m] 
DimensionDescription|Origin 3 = -1.500012e-005 [physical origin z, m] 
DimensionDescription|Unit 1 = m 
DimensionDescription|Unit 2 = m 
DimensionDescription|Unit 3 = m 
HardwareSetting|FilterSettingRecord|AOTF (405) 1 = 0 
HardwareSetting|FilterSettingRecord|AOTF (405) 2 = 0 
HardwareSetting|FilterSettingRecord|AOTF (458) 1 = 0 
HardwareSetting|FilterSettingRecord|AOTF (458) 2 = 0 
HardwareSetting|FilterSettingRecord|AOTF (476) 1 = 0 
HardwareSetting|FilterSettingRecord|AOTF (476) 2 = 0 
HardwareSetting|FilterSettingRecord|AOTF (488) 1 = 1.00103766099005 [gain ] 
HardwareSetting|FilterSettingRecord|AOTF (488) 2 = 0 [offset] 
HardwareSetting|FilterSettingRecord|AOTF (514) 1 = 0 
HardwareSetting|FilterSettingRecord|AOTF (514) 2 = 0 
HardwareSetting|FilterSettingRecord|AOTF (561) 1 = 0 
HardwareSetting|FilterSettingRecord|AOTF (561) 2 = 0 
HardwareSetting|FilterSettingRecord|AOTF (633) 1 = 0 
HardwareSetting|FilterSettingRecord|AOTF (633) 2 = 0 
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HardwareSetting|FilterSettingRecord|DMI6000 Stage Pos x 1 = 0.03751998567257 
HardwareSetting|FilterSettingRecord|DMI6000 Stage Pos y 1 = 0.00860454637572 
HardwareSetting|FilterSettingRecord|DMI6000 Stage Pos z 1 = 0 
HardwareSetting|FilterSettingRecord|DMI6000 Stage XOrigin 1 = 0 
HardwareSetting|FilterSettingRecord|DMI6000 Stage YOrigin 1 = 0 
HardwareSetting|FilterSettingRecord|DMI6000 Stage ZOrigin 1 = 0 
HardwareSetting|FilterSettingRecord|Dummy Name (Obj.) 1 = Dummy5 
HardwareSetting|FilterSettingRecord|Excitation Beam Splitter FW 1 = RT 30/70 [ ] 
HardwareSetting|FilterSettingRecord|Galvo Slider 1 = Galvo X Normal  
HardwareSetting|FilterSettingRecord|Hardware Type No. 1 = 7 
HardwareSetting|FilterSettingRecord|Laser output power 1 = 19.9115044247788 [Ar output power 20%] 
HardwareSetting|FilterSettingRecord|Laser wavelength 1 = 405 
HardwareSetting|FilterSettingRecord|Laser wavelength 2 = 458 [refers to Ar laser, not really using the 458 
HardwareSetting|FilterSettingRecord|Laser wavelength 3 = 561 
HardwareSetting|FilterSettingRecord|Laser wavelength 4 = 633 
HardwareSetting|FilterSettingRecord|Magnification-Changer 1 = SCANx 
HardwareSetting|FilterSettingRecord|Numerical aperture (Obj.) 1 = 1.4 
HardwareSetting|FilterSettingRecord|Objective 1 = HCX PL APO CS  63.0x1.40 OIL  UV [ ] 
HardwareSetting|FilterSettingRecord|Order number (Obj.) 1 = 11506188 
HardwareSetting|FilterSettingRecord|PMT 1 1 = Inactive 
HardwareSetting|FilterSettingRecord|PMT 2 (HV) 1 = 375.562676432441 
HardwareSetting|FilterSettingRecord|PMT 2 (HV_Unit) 1 = V 
HardwareSetting|FilterSettingRecord|PMT 2 (Offs.) 1 = 0 
HardwareSetting|FilterSettingRecord|PMT 2 (Preamp) 1 = Standard 
HardwareSetting|FilterSettingRecord|PMT 2 1 = Active [ ] 
HardwareSetting|FilterSettingRecord|PMT 3 1 = Inactive 
HardwareSetting|FilterSettingRecord|PMT 4 1 = Inactive 
HardwareSetting|FilterSettingRecord|PMT Trans 1 = Inactive 
HardwareSetting|FilterSettingRecord|Phase 1 = -36.5224689097429 
HardwareSetting|FilterSettingRecord|Polarization FW 1 = Empty 1  
HardwareSetting|FilterSettingRecord|Position 1 = 3 
HardwareSetting|FilterSettingRecord|Power State 1 = Off 
HardwareSetting|FilterSettingRecord|Power State 2 = On [ ] 
HardwareSetting|FilterSettingRecord|Power State 3 = Off 
HardwareSetting|FilterSettingRecord|Power State 4 = Off 
HardwareSetting|FilterSettingRecord|RLD_Settings 1 = -1 
HardwareSetting|FilterSettingRecord|Refraction index 1 = 1.518 
HardwareSetting|FilterSettingRecord|Reson. Galvo Pan 1 = Galvo X Pan Center  
HardwareSetting|FilterSettingRecord|Rotation Direction 1 = 1 
HardwareSetting|FilterSettingRecord|SMD-Phase 1 = 0 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 1 (left) 1 = 406.25 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 1 (right) 1 = 458.75 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 1 (stain) 1 =  
HardwareSetting|FilterSettingRecord|SP Mirror Channel 2 (left) 1 = 470 [ ] 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 2 (right) 1 = 500 [ ] 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 2 (stain) 1 =  
HardwareSetting|FilterSettingRecord|SP Mirror Channel 3 (left) 1 = 616.25 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 3 (right) 1 = 668.75 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 3 (stain) 1 =  
HardwareSetting|FilterSettingRecord|SP Mirror Channel 4 (left) 1 = 721.25 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 4 (right) 1 = 773.75 
HardwareSetting|FilterSettingRecord|SP Mirror Channel 4 (stain) 1 =  
HardwareSetting|FilterSettingRecord|Scan Field Rotation 1 = -1.39513951395139 
HardwareSetting|FilterSettingRecord|Scan Speed 1 = 400 [ ] 
HardwareSetting|FilterSettingRecord|System Number 1 = 5100001224 
HardwareSetting|FilterSettingRecord|TLD_Settings 1 = 100 
HardwareSetting|FilterSettingRecord|Target Slider 1 = Target Park 
HardwareSetting|FilterSettingRecord|UV Lens FW 1 = Lens 63x/1.4 Oil  
HardwareSetting|FilterSettingRecord|X Scan Actuator (Gain) 1 = 9.99996185317286 
HardwareSetting|FilterSettingRecord|X Scan Actuator (Offs.) 1 = 8.67361737988404E-19 
HardwareSetting|FilterSettingRecord|X Scan Actuator (POS) 1 = 0 
HardwareSetting|FilterSettingRecord|X Scan Actuator 1 = Active 
HardwareSetting|FilterSettingRecord|Y Scan Actuator (Gain) 1 = 9.99996185317286 
HardwareSetting|FilterSettingRecord|Y Scan Actuator (Offs.) 1 = 1.16407704723806E-06 
HardwareSetting|FilterSettingRecord|Y Scan Actuator (POS) 1 = 0 
HardwareSetting|FilterSettingRecord|Y Scan Actuator 1 = Active 
HardwareSetting|FilterSettingRecord|Y-Phase 1 = 0 
HardwareSetting|FilterSettingRecord|Z Scan Actuator (POS) 1 = 0 
HardwareSetting|FilterSettingRecord|Z Scan Actuator (POS) 2 = -4.97127053381973E-06 
HardwareSetting|FilterSettingRecord|Z Scan Actuator 1 = Inactive 
HardwareSetting|Name 1 = default 
HardwareSetting|ScannerSettingRecord|SystemType 1 = TCS SP5 
HardwareSetting|ScannerSettingRecord|bAFUseFixSliceNumber 1 = 0 
HardwareSetting|ScannerSettingRecord|bEnableRoiScan 1 = 0 
HardwareSetting|ScannerSettingRecord|bIs3DLimitedRoiScanEnable 1 = 0 
HardwareSetting|ScannerSettingRecord|bIsSequential 1 = 0 
HardwareSetting|ScannerSettingRecord|bStepSizeConstant 1 = 1 
HardwareSetting|ScannerSettingRecord|bStepSizerActivated 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseCARSLight 1 = 0 
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HardwareSetting|ScannerSettingRecord|bUseChaserUVShutter 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseChaserVisibleShutter 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseFSOPOLight 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseMP2Shutter 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseMPShutter 1 = 0 
HardwareSetting|ScannerSettingRecord|bUsePulsed635VisibleLight 1 = 0 
HardwareSetting|ScannerSettingRecord|bUsePumpLight 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseSTED1Light 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseSTED2Light 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseSTED3Light 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseSTED4Light 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseStokesLight 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseSuperContVisibleShutter 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseUV405Shutter 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseUVShutter 1 = 0 
HardwareSetting|ScannerSettingRecord|bUseVisibleShutter 1 = 1 
HardwareSetting|ScannerSettingRecord|bValidBegin 1 = 1 
HardwareSetting|ScannerSettingRecord|bValidEnd 1 = 1 
HardwareSetting|ScannerSettingRecord|csLutName0 1 = Green 
HardwareSetting|ScannerSettingRecord|csLutName1 1 = Red 
HardwareSetting|ScannerSettingRecord|csLutName2 1 = Blue 
HardwareSetting|ScannerSettingRecord|csLutName3 1 = Gray 
HardwareSetting|ScannerSettingRecord|csLutName4 1 = Gray 
HardwareSetting|ScannerSettingRecord|csScanMode 1 = xyz [current scan mode] 
HardwareSetting|ScannerSettingRecord|dblAFFocusRange 1 = 0.00005 
HardwareSetting|ScannerSettingRecord|dblFocusStabilizerPSDOffset 1 = -2 
HardwareSetting|ScannerSettingRecord|dblPinhole 1 = 4.77129376133485E-05 [pinhole, m] 
HardwareSetting|ScannerSettingRecord|dblPinholeAiry 1 = 0.499475929206169 [pinhole, airy] 
HardwareSetting|ScannerSettingRecord|dblSizeX 1 = 2.46032684568375E-05 
HardwareSetting|ScannerSettingRecord|dblSizeY 1 = 9.01218624792582E-08 
HardwareSetting|ScannerSettingRecord|dblSizeZ 1 = 1.00288486755835E-05 
HardwareSetting|ScannerSettingRecord|dblStepSize 1 = 4.196170993968E-08 
HardwareSetting|ScannerSettingRecord|dblVoxelX 1 = 6.00812416528388E-09 [voxel-width, m] 
HardwareSetting|ScannerSettingRecord|dblVoxelY 1 = 6.00812416528388E-09 [voxel-height, m] 
HardwareSetting|ScannerSettingRecord|dblVoxelZ 1 = 4.196170993968E-08 [voxel-depth, m] 
HardwareSetting|ScannerSettingRecord|dblZoom 1 = 9.99996185317286 [ ] 
HardwareSetting|ScannerSettingRecord|dwChannelMask 1 = 4 
HardwareSetting|ScannerSettingRecord|dwLogiChMask 1 = 2 
HardwareSetting|ScannerSettingRecord|eAFAnalyseType 1 = 1 
HardwareSetting|ScannerSettingRecord|eAFSubsystem 1 = 0 
HardwareSetting|ScannerSettingRecord|eAFWorkflowTimelapse 1 = 1 
HardwareSetting|ScannerSettingRecord|eAFWorkflowXY 1 = 1 
HardwareSetting|ScannerSettingRecord|eAFZUseMode 1 = 1 
HardwareSetting|ScannerSettingRecord|eDataSource 1 = 0 
HardwareSetting|ScannerSettingRecord|eDirectional 1 = 1 
HardwareSetting|ScannerSettingRecord|eDirectionalY 1 = 1 
HardwareSetting|ScannerSettingRecord|eSequentialMode 1 = 0 [ ] 
HardwareSetting|ScannerSettingRecord|eZUseMode 1 = 1 
HardwareSetting|ScannerSettingRecord|nAFFixSliceNumber 1 = 0 
HardwareSetting|ScannerSettingRecord|nAFPrecision 1 = 2 
HardwareSetting|ScannerSettingRecord|nAFWorkflowTimelapseIterator 1 = 1 
HardwareSetting|ScannerSettingRecord|nAFWorkflowXYIterator 1 = 1 
HardwareSetting|ScannerSettingRecord|nAccumulation 1 = 1 
HardwareSetting|ScannerSettingRecord|nAverageFrame 1 = 1 [ ] 
HardwareSetting|ScannerSettingRecord|nAverageLine 1 = 3 [ ] 
HardwareSetting|ScannerSettingRecord|nBegin 1 = 492830 
HardwareSetting|ScannerSettingRecord|nBit 1 = 8 
HardwareSetting|ScannerSettingRecord|nChannels 1 = 1 
HardwareSetting|ScannerSettingRecord|nEnd 1 = 513862 
HardwareSetting|ScannerSettingRecord|nFormatInDimension 1 = 4096 
HardwareSetting|ScannerSettingRecord|nFormatOutDimension 1 = 16 
HardwareSetting|ScannerSettingRecord|nLineAccumulation 1 = 1 
HardwareSetting|ScannerSettingRecord|nLines 1 = 9.99996185302825 
HardwareSetting|ScannerSettingRecord|nPages 1 = 9.99996185302735 
HardwareSetting|ScannerSettingRecord|nSections 1 = 240 
IsPreviewImage 1 = 0 
Location = E:\pang\work\SP5\leica test files\z-res 02.lif [ ] 
Memory|MemoryBlockID 1 = MemBlock_79 
Memory|Size 1 = 15728640 
Name 1 = PreviewMarker  
Name 2 = HardwareSettingList 
Name 3 = ChannelAttachment 
Name 4 = ViewerScaling 
Name 5 = ImageXMLDocument 
Name 6 = Image028 [this entry belongs to the next series, don't know why it should be here] 
Quantity|Unit 1 = m 
Quantity|Unit 2 = m 
Quantity|Unit 3 = V 
Quantity|Unit 4 = V 
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Quantity|Value 1 = 0.00000047 
Quantity|Value 2 = 0.0000005 
Quantity|Value 3 = 375.562676432441 
Quantity|Value 4 = 0 
TimeStamp|HighInteger 1 = 30107055 [each slice, ordinal sort order] 
TimeStamp|HighInteger 10 = 30107055 
... [entries deleted for brevity] 
TimeStamp|LowInteger 98 = 3385276720 
TimeStamp|LowInteger 99 = 3389326720 
 
------------------------ 
 
[these are metadata returned by ImageJ] 
Title: z-res 02.lif - Series026 
Width:  24.60 microns (4096) 
Height:  0.09 microns (16) 
Depth:  10.07 microns (240) 
X Resolution:  166.482 pixels per micron 
Y Resolution:  177.537 pixels per micron 
ID: -14 
Coordinate origin:  0,0,0 
Bits per pixel: 8 (color LUT) 
Display range: 0-255 
Image: 1/240 (z:1/240 - Series026) 
No Threshold 
Magnification: 0.25 
Uncalibrated 
Path: E:\pang\work\SP5\leica test files\z-res 02.lif 
No Selection 
  
    


